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Resources and Slides Available Now I AMAC

ACCESSIBILITY

WAG Website, under GT Training

WAG Georgia Tech Training

WAG

Web Accessibility Group
for Higher Education


http://www.amacusg.gatech.edu/wag/GT_Training

Purpose of Today’s Training I AMAC

ACCESSIBILITY

* Describe Georgia Tech’s Commitment to Accessible ICT

* Provide Foundational Training: ICT Accessibility in Higher Education

 Whatis your role in ensuring ICT accessibility at Georgia Tech?
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Tell Us About Yourself I AMAC

ACCESSIBILITY

* Name

Department or Unit

Role

* Newcomer or Previous Experience with Web/ICT Accessibility



About AMAC I AMAC

ACCESSIBILITY

AMAC Accessibility Solutions and Research Center

* Help others provide equal access to education, work and life for individuals with disabilities

* Services

* Accessibility Compliance, Assistive Technology, Braille, Captioning, E-Text, etc.

* Initiatives
* Access Text Network
* Tools for Life
* Web Accessibility Group (WAG) for Higher Education
* and others...



Why ICT Accessibility Is
Important in Higher Education

AMAC

ACCESSIBILITY

Janet Sylvia, AMAC
Coordinator - Web Accessibility Group (WAG) for Higher Education



ICT in Higher Education I AMAC

ACCESSIBILITY

Audience ICT Commonly Used
* Employees and Prospective Employees * Academic and Online Course Content
e Students and Prospective Students * Databases

* Dynamic Rich Internet Applications

* E-commerce, Online Payment Systems
* Electronic Documents

* Learning Management System

* Library Services

* Registration Systems

* Software Programs

* Tutorials

* Video and Web Conferencing Solutions
*  Websites and Web-based Applications
* etc.

* Members of the public




Why ICT Accessibility is Important / AMAC

ACCESSIBILITY

Tamara Rorie
Attorney



https://www.youtube.com/watch?v=EOKROOnquuk
https://www.youtube.com/watch?v=EOKROOnquuk
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ABOUT Gegroia |

Reason for Policy:

v The Georgia Institute of Technology is committed to providing
equality of opportunity to persons with disabilities, including
equal access to Institute programs, services and activities
provided through Information Technology.

v" This policy establishes minimum standards and expectations

regarding the design, acquisition or use of Information
Technology.
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POLICY OWNERS Gegroia |

v’ Office of Compliance Programs —ADA Compliance Coordinator

v’ Office of Information Technology —IT Accessibility Coordinator

TITITTITII TN I I I I 11T AT I I T AT I I IN AT I a7/ CREATING THE NEXT®



APPLICABILITY Gegrgia |

This policy applies to all IT resources that
are acquired, developed, distributed, used,
purchased or implemented by or for any
Institute unit and used to provide Institute
programs, services, or activities
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“IT” REFERS TO... Gegrgla |

Tec

Any equipment or interconnected system or subsystem of
equipment, that is used in the automatic acquisition, storage,
manipulation, management, movement, control, display,

switching, interchange, transmission, or reception of data or
information.

TITITTITII TN I I I I 11T AT I I T AT I I IN AT I a7/ CREATING THE NEXT®



“IT” INCLUDES...

v' Computers

v Ancillary Equipment

v’ Software

v Firmware and similar procedures

v’ Services (including support
services), and related resources

Georgia @]
Tech )
v' Instructional materials
v’ Videos
v' Multimedia
v’ Telecommunications
v' Web-Based Content

v' Products developed, procured,
maintained, or used in carrying out
Institute activities

TITITTITII TN I I I I 11T AT I I T AT I I IN AT I a7/ CREATING THE NEXT®



SCOPE & JURISDICTION Ge?r'é%’:‘ﬁ&

* Incorporating a universal design approach ensures resources (documents, web pages,
information, and services) are accessible to the broadest possible audience.

* Individual web pages published by students, employees or non-Institute organizations
that are hosted by the Institute and which do not conduct Institute-related business
are encouraged to adopt the accessibility standards contained in this policy, but fall
outside the jurisdiction of this policy.
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WEB PAGES Gegraia |

* All new web pages and Revised Web Pages, website templates, and
website themes must comply with the Institute’s Accessibility
Standards.

* All new and Revised Web Pages must indicate in plain text a method
for users having trouble accessing the page to report that
inaccessibility.

TITITTITII TN I I I I 11T AT I I T AT I I IN AT I a7/ CREATING THE NEXT®



LEGACY PAGES Gegraia |

* Legacy Pages determined by the publishing department or
unit to be of the highest priority in providing Institute
services online (core institutional information) shall comply

with the Institute’s Accessibility Standards.

TITITTITII TN I I I I 11T AT I I T AT I I IN AT I a7/ CREATING THE NEXT®
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WEB PAGE COMPLIANCE GeorgiﬁIA]

Unless an institute level exception has been granted, any Legacy
Web Page or any other web page that for any reason does not
comply with the Institute’s Accessibility Standard, the institute
will upon request:

» Convert or render the non-compliant web page so as to meet
the Institute’s Accessibility Standards or

» Provide to the requestor access to the web page’s information
in manner that is equally effective as the original page.

TITITTITII TN I I I I 11T AT I I T AT I I IN AT I a7/ CREATING THE NEXT®



PURCHASING Ge?r'é%ﬁ&

Considering accessibility in procurement involves the following
steps:

* Vendors must be asked to provide information about the
accessibility of their products as required by the Institute’s
Computer Technology Request (CTR) process.

* The information provided by vendors must be valid and
measured using a method that is reliable and objective.

TITITTITII TN I I I I 11T AT I I T AT I I IN AT I a7/ CREATING THE NEXT®



VENDORS Gegraia |

Tec

* Those making procurement decisions must be able to objectively evaluate the
accessibility of products and to scrutinize the information provided by vendors.

* Assistance with ensuring that appropriate contractual language is included in all IT
purchasing documents may be obtained through the Institute’s Purchasing Office.

TITITTITII TN I I I I 11T AT I I T AT I I IN AT I a7/ CREATING THE NEXT®
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WHERE TO FIND POLICY Georgiﬁ@]

IT Accessibility Policy
Policy Library

ada.gatech.edu

TITITTITII TN I I I I 11T AT I I T AT I I IN AT I a7/ CREATING THE NEXT®


https://policylibrary.gatech.edu/information-technology/information-technology-accessibility-policy
http://www.ada.gatech.edu/

Laws and Guidelines for Accessible ICT

AMAC

ACCESSIBILITY

Dr. Linda Gilbert, AMAC
Accessibility Specialist



Laws, Guidelines, and Policies I AMAC

ACCESSIBILITY

ADA | WCAG 2.0 ‘
CVAA o
Section 503 3 ‘
u =
Section 504 < Section 508
Section 508 § < E
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WCAG 2.0 USG Position I I I ‘ 4

University System of Georgia (USG) Position



Americans with Disabilities Act (ADA) I AMAC

ACCESSIBILITY

Addresses Non-discrimination/Equal Opportunity in:
* Employment

» State and local government services

* Public accommodations

* Commercial facilities
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* Transportation

Current ADA Regulations



https://www.ada.gov/2010_regs.htm

CVAA I AMAC

ACCESSIBILITY

215t Century Communications and Video Accessibility act (CVAA)

e Update of prior telecommunications laws
* Administered by Federal Communications Commission (FCC)




Sections 503 and 504 I AMAC

ACCESSIBILITY

Part of the (much amended) Rehabilitation Act of 1973.

* The Rehabilitation Act, Section 501, prohibits
employment discrimination based on disability in the
federal sector.

e Section 503 expands coverage to include federal
contractors and subcontractors

e Section 504 addresses participation in “any program or
activity receiving Federal financial assistance”

* Section 504 specifically includes education.
e Civil rights!




Section 508: ICT Access I AMAC

ACCESSIBILITY

e Part of the (much amended) Rehabilitation Act of 1973.
* Addresses accessibility of Information and Communications Technology (ICT)
e Applies to Federal agencies that "develop, procure, maintain, or use electronic and

information technologies."

e Standards set by US Access Board ‘_
* Amended in January 2017 %

* Enforcement begins January 2018.




University System of Georgia position I AMAC
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* Higher Education, the Americans with Disabilities Act, and Section 508
* Web Accessibility and Persons with Disabilities

* Requires 508



Section 508 Standards I AMAC

ACCESSIBILITY

* Recent update addresses changes in technology since last update (2000)
* Incorporates WCAG 2.0 by reference
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WCAG 2.0 I AMAC

ACCESSIBILITY

Web Content Accessibility Guidelines (WCAG) — international standards
for web, set by World Wide Web Consortium (W3C).

“WCAG 2.0 is a stable, referenceable technical standard. It has 12
guidelines that are organized under 4 principles: perceivable, operable,
understandable, and robust. For each guideline, there are

testable success criteria, which are at three levels: A, AA, and AAA.”

- Source: Web Content Accessibility Guidelines (WCAG) Overview



https://www.w3.org/TR/WCAG20
http://www.w3.org/TR/UNDERSTANDING-WCAG20/intro.html#introduction-fourprincs-head
http://www.w3.org/TR/UNDERSTANDING-WCAG20/conformance.html#uc-levels-head
https://www.w3.org/WAI/intro/wcag

Incorporation of WCAG 2.0 I AMAC

ACCESSIBILITY

« WCAG 2.0, levels A and AA, now incorporated by reference into
508 standards

* Application of WCAG 2.0 broadened to apply to non-web ICT as
well



Relationship of WCAG 2.0 and 508 l AMAC

ACCESSIBILITY




Approximate timeline I AMAC

ACCESSIBILITY

Rehabilitation Act I WCAG 2.0_
- Section 501 I_ ‘ ADA
- Section 503 3
- Section 504 E L Section 508
- Section 508 I <

3 <

L

Section 503

CUAA USG Position |_| | |

508 Standards Update
* Incorporating WCAG 2.0 by reference



For more information I AMAC

ACCESSIBILITY

American with Disabilities Act (ADA)

215t Century Communications and Video Accessibility Act (CVAA)
Section 503

Section 504

Section 508

Text of the standards and guidelines

Revised Section 508 Toolkit

Web Content Accessibility Guidelines (WCAG) Overview

WCAG 2.0



https://www.ada.gov/
https://www.fcc.gov/general/twenty-first-century-communications-and-video-accessibility-act-0#block-menu-block-4
https://www.dol.gov/ofccp/regs/compliance/section503.htm
https://www.dol.gov/oasam/regs/statutes/sec504.htm
https://www.section508.gov/
https://www.access-board.gov/guidelines-and-standards/communications-and-it/about-the-ict-refresh/final-rule/text-of-the-standards-and-guidelines#502-interoperability-assistive-technology
https://section508.gov/refresh-toolkit
https://www.w3.org/WAI/intro/wcag
https://www.w3.org/TR/WCAG20/

Questions?, Part 1

AMAC

ACCESSIBILITY



BREAK
until 10:30am

AMAC

ACCESSIBILITY



Assistive Technology (AT) and
Web-based Environments

AMAC

ACCESSIBILITY

John Rempel, AMAC
Quality Control Accessibility Analyst



How People with Disabilities y
Use the Web bl S

Auditory

Cognitive and Neurological
Physical

Speech

Visual



Speech-to-Text I\ AMAC
ACCESSIBILITY

* Siri (Apple)
* Google Now (Google)

* Cortana (Microsoft)




TTS and STT Combination A AMAC

ACCESSIBILITY

amazonecho
N—"

Always ready, connected, and fast. Just ask.
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Text-to-Speech I\ AMAC

ACCESSIBILITY

* JAWS

°* NVDA

* VoiceOver (Mac)
* VoiceOver (iOS)

* TalkBack for Android

* Window-Eyes

‘/_Q\" window-Eyes



Refreshable Braille Displays éCEéMég

* Refreshable Braille Displays




Optical Character Recognition I\ AmAC

ACCESSIBILITY

* Open Book (] Kurzweil 1000

* Kurzweil 1000

* Text Cloner Pro




Screen Magnification Programs I\ AMmAC
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Speech Recognition Software AICCE';*J\QAF

Turn spoken words into text

Connect with the timing of
your thoughts

DRAQON

Dictation speed 70 to 100
words per minute




Video of Student Using Speech-to-Text

I AMAC

ACCESSIBILITY

Technology

Video of Student integrating speech-to-text solutions into her
personal life and educational pursuits.



https://www.youtube.com/watch?v=R_Tf_L5yGes
https://www.youtube.com/watch?v=R_Tf_L5yGes

ClaroRead
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dovelaps and licenues Assistive Softvaz, irclusing specoh techralogy,
irge techeoingy and toweh cechnology. With Windows and Nac
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Text-to-Speech
Visual Highlighting

Read back any on-screen
text and program
commands

High Quality Screen Reader
Keyboard Echo
Save to Audio

I AMAC

ACCESSIBILITY



Premier Literacy Suite I\ AMmAC

ACCESSIBILITY

Text-to-Speech
software

Post writing to “cloud
applications”

Scan and read
documents

Integrated Dictionary
Create study notes



Perspective Videos: W3C-WAI, Part 1 I AMAC

ACCESSIBILITY

Perspectives Videos

Keyboard Compatibility Colors with Good Contrast

Clear Layout and Design . Text to Speech

Large Links, Buttons, and Controls Video Captions

Customizable Text Voice Recognition

Understandable Content Notifications and Feedback




Screen Reader Demonstration I AMAC

ACCESSIBILITY

* Title Page

* Links

* Headings

* Graphics

* Multimedia

* Tables

* Keyboard Access

°* Low Vision



Questions?, Part 2

AMAC
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Basic Principles of Accessible
Web Content

AMAC

ACCESSIBILITY

Dr. Linda Gilbert, AMAC
Accessibility Specialist



1) Accessibility Statement

Purpose:
* Set visitor expectations

Includes:

e Technology Standards
* Known Issues

e Accessible Alternatives
e Contact Information

Reviewed by Legal Department

j AMAC

ACCESSIBILITY

The Georgla Institute of Technology is committed to providing
both physical accessibility and access to information resources
and technolegies to individuals with disabilities.

The Inshtute’s vesion 1S 10 creale a cullure of access for an inclusive leaming and working

environmant The Inshtude’s commdment 1o accassbility for all 1s highaghtad in the

numarous suppori, rasearch, and product development centars on campus for students and

employees with disabdities

Disabiity Sarvices, localed in the Dean of Students Office, provides suppodt

purce information for students with disabilities st the Institute The Offce of

Disabaity Services sarves Ceorgia Tach students wih documented qualifying disabiibes

operates under the guedelnes of Section 504 of 1he Rehabditabion Act of 1973 and the

Amencans with Disabiimes Act and 115 amendmeants (ADAAA)

Siméarly, Employee Relations - located in the Office of Human Resources - provdes
support and resource information for employees and visdors with gisabdities Services are
gvailable 1o ensure that mdwiduals with dsablities have an equel coportumnity to pursue
educabon and employment and to hava access 10 campus programs, aclivibas, and

Sefvices

In adadion 0 the Georgla Tech Office of Disability Senices ang Employes Relavons, the

Institute 1s committes 1o aghering 10 accessibility kegisiabon for publkshing electronic

miarmaton as nofed in Secton 504 of the Rehabditabon Act of 1673

Accessibility Contact

For any accessiility issue
please contact GT Accessibiity

Email
Qtaccessibdity@uatech.edu

Accessibility News

Presidential Commities to
Oversse Campus Accassibiity

May 13, 2011 — T wemure that none of



http://www.gatech.edu/accessibility/
http://www.gatech.edu/accessibility/

2) Readability

Book

l AMAC

ACCESSIBILITY

What makes it readable?

Title
Language
Navigation (consistent)
Skip to main content
Structure
* Headings
* Lists
Font clarity
Images
Whitespace




Readability Online / AMAC

ACCESSIBILITY

Websites Electronic Documents

LN

\\




Basic Concepts of Readability Online

j AMAC

ACCESSIBILITY

Language
Page Titles
Skip to Main Content
Navigation
* Consistent
Structure
* Headings
 Lists (chunk information)
* Reading sequence

Consistent
Left-justified
Magnified 200%
Simple
Standard

True Text

Images

Whitespace




Headings / AMAC

ACCESSIBILITY




Heading Structure j AMAC

ACCESSIBILITY

Semantic headings Visual-only

Heading 1 text text text link text text text text text
text text link text text text text text text
link text text text text text text text text
text text text link text text text text text
text text link text text text text text text
text text text text text link text text text
text text text text text text text text link
text text text text text text text link text
text text text text text text link text text
text text text text text text text text text
text link text text text text text text text
text text text text link text text text text
text text text text text text text link text
text text text text text text text text text

Normal text
s Hyperlink
s |[mage
Normal text
Heading 2
Normal text
s Hyperlink
Normal text
s Hyperlink
Heading 3
Normal text
Normal text




Use Heading Styles

< IDOCTYPE html>
<html>
<body>»

<h6>This is he

</body>
</ html>

<h13This is he s
<h2»This is he °©
<h3>This is he _
<h4sThis 1is hi =
<h53This is he femeia [

j AMAC

ACCESSIBILITY

Provide document structure
Detectable by screen readers
Useful for navigation

Can easily be modified

Not the same as visual changes in font
size or color

Should use “levels” sequentially



3) Alt Text

Provide a text equivalent for every non-
text element

Alt text:
* Clear, concise description
e Approx. 120 characters or less
* Conveys function, purpose, or meaning

Long Description (in addition to alt text):

* When alt text alone isn’t enough

* Surrounding text or link to a separate,
accessible document

I AMAC

ACCESSIBILITY

. Chart
a2

N
S b

M Series 2 M Series 3



Consider Context and Function l AMAC

ACCESSIBILITY

® 1) Website Content

alt = “Yellow tulips blooming in the
Spring”

® 2) Horticulture Class
alt=“Tulipa gesneriana”

® 3) Image is a Link
alt="Tulip Society of America”

® 4) Image is Decoration

a|t=ll"




4) Color and Contrast j AMAC

ACCESSIBILITY

* Use a high contrast color scheme

* Make sure background does not overpower text

* Use color schemes consistently

* Provide alternatives for color coding



Colour Contrast Analyser I AMAC

ACCESSIBILITY

Colour Contrast Analyser — X
Options |mage Help

Foreground Background

Colour select: Hex: Colour select Hex:

| v| A~ #FFFFFF | (DN - 7~

Result - luminosity

Text Foreground:#FFFFFF Basic P_rlnmples of
v Background:#03316C Accessible Web Content
V’ SEEE The contrast ratio is: 12.7:1 AMAC November 9, 2017

Large text ACCESSIBILITY Linda S. Gilbert

Text passed at Level AA
vd Pass (AA) Text passed at Level AAA
Large text passed at Level AA
Y4 Pass (AAA) Large text passed at Level AAA

[[]Show contrast result for colour blindness Copy results




Use Color Schemes Consistently %%AMAC

ACCESSIBILITY




Alternatives for Color Coding Example 1 I AMAC

ACCESSIBILITY
Color alone . Color plus labels .

Example 1: Which is the parallelogram? Example 1: Which is the parallelogram?
o Red O Red (1)
O Green - o Green (2) n

O Blue O Blue (3)




Alternatives for Color Coding Example 2

Technical Standards (Subpart B)

The stancercs if@/‘de critens siecﬁc 10 vanous types of technologles, Including

*  web-basaed nformasion or spolications

¢ talecomms on products

s ideo and multimedia products

« N - o nformation kosks, calculstors, snd fax machines)

¢ deskiop and poriable computers
This section provides technical specfications and performance-based requirements, which focus on the
functonal capabdites of covered fechnologies. This dusl approach recognizes the dynamic and
ocontinually evolving nature of the fechnology involved as well as the need for clear and specific standards
to faciitate complisnce. Certain provisions are designed 10 ensure compatidility with adapive equipment
people with dissbilties commonly s for information and communication Sccess. SLUCH 85 FOresen
readers, Braille displays, and TTYs

Most of the specificaions for scftware to usal for ple with vision impaiments. For
example,  ONE Provison requires Mﬂch 15 @ssential for people with
vision impairments who cannot rely on pointing devices, such as a mouse. Other provisions address
animated displays color and contrast sett fash rate. and electronic forms, amang others

Web-based Intranet and Internet information and Applications (11

94.22)

The oritena for web-basaed technology and information are based on access guidelines developed
by the Web Accessibiity Initistive of he World Wide Web ConsorSium. Many of these peovisions ensure

acoess for paople with vision impairments who rely on vanous assistive products to Ro0ess computer-
based information, such as screen resders, which transiste what's on 8 computer screen into sutomated
sudible out and refreshable Braille displays. Certsin conventions, such as verbal 1ags or identfication
aih fike frames. are necessary 30 that these devices can “read” them for the
user in & sensible way. The standards do not prohibit the ﬁ Instead
the standards aim to ensure that such information = slso isble in an ible format G y, this
means use of text labels or dascriptors for graphics and certain formsat elements. (HTML code svesdy
provides an "Alt Text" tag for graphics which can serve &5 8 verbsl descriptor for graphics). This section
also addresses the usability of multimedia prasentations, image maps, style sheets, scripting languages
applets and plug-ns. and electronic forms. The standards apply to Faderal web sites but not 1o private
sector web sites (unless a site is provided under contract to a Federal agency, in which case only that

I AMAC
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Technical Standards

Software Applications

* Software

* Operating Systems

* Web-based Graphics
Web based Content

* Internet and Intranet
Self-contained

* Closed products

* Kiosks

* Fax Machines



5) Hyperlinks j AMAC

ACCESSIBILITY

Link text should:

* make sense out of context

* describe the destination
* unique for each unique destination

Avoid
* Click here
* Email me
* URL text http://www.gtllo-b59-g02376c.html



Aggregated Links - Vague j AMAC

ACCESSIBILITY

Vague

Logo
Image
WAI
WAI
WAI
Link
Link
Link




Aggregated Links - Descriptive j AMAC

ACCESSIBILITY

Vague Descriptive
Logo W3C
Image Web Accessibility Initiative
WAI WAI Develops...
WAI WAI Welcomes...
WAI WAI Home
Link Guidelines and Techniques
Link Planning and Implementation
Link Evaluation




6) Accessible Multimedia, Part 1 j AMAC

ACCESSIBILITY

Audio-only ‘))) Video-only %

* Text Transcript * Video Description

Al Al



6) Accessible Multimedia, Part 2

Audio+Video B\

* Closed Captions

* Text Transcript + Video Description

Closed Caption

feature

Turn off Captions ‘1 m
cosr404 | o) Q) 0 29

j AMAC

ACCESSIBILITY

Accessible Media
Player




7) Tables l AMAC

ACCESSIBILITY

T

Logical Reading Order (i.e. Linearized)

Simple vs. Nested

True Tables



Reading Order, Part 1 l AMAC
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Makes sense when read from top to bottom and left to right




Row and Column Headers l AMAC

ACCESSIBILITY




Define Relationships l AMAC
ACCESSIBILITY

==




Tables Properly Coded j AMAC

ACCESSIBILITY

Caption
« Title

Headers
* Column Headers
* Row Headers

Data Cells

Summary
* Describes organization of table

True Tables



Summary J AMAC

ACCESSIBILITY

Accessibility Statement

Readability and Structure
Alt Text

Color and Contrast
Hyperlinks

Multimedia

Tables



Perspective Videos: W3C-WAI, Part 2

Perspectives Videos

Keyboard Compatibility Colors with Good Contrast

Clear Layout and Design Text to Speech

Larpe Links, Buttons, and Controls Video Captions

Customizable Text Voice Recognition

M Understandable Content Notifications and Feedback

l AMAC

ACCESSIBILITY



Questions?, Part 3

AMAC

ACCESSIBILITY



LUNCH and AMAC Tour
Lunch: 12:00 — 12:30pm
AMAC Tour: 12:30 — 1:30pm

AMAC

ACCESSIBILITY



Accessible Word, PowerPoint
and PDF Documents

AMAC

ACCESSIBILITY

Tim Georges, AMAC
E-Text Accessibility Specialist



AMAC Accessibility Solutions I\ AMAC

ACCESSIBILITY

AMAC was created in 2005 to provide complete,
timely, and efficient accommodations to students
with print related disabilities. We first started with
textbook conversion, and have added many
departments and services over the years.




AMAC’s Products and Services I AMAC

ACCESSIBILITY

E-Text Production provides textbooks, supplements, journals, brochures, and
manuals in a variety of accessible electronic formats, including PDF, DOC, DAISY,
PowerPoint, HTML, and MathML files.

Braille Services produce timely, cost-effective, high-quality electronic and
embossed Braille and custom tactile graphics.

Captioning and Described Media Services make classroom lectures, meetings,
labs, or webinars fully accessible for deaf or hard-of-hearing and provide post-
production transcripts, captioning, and described video.

Assistive Technology Team conducts on-site and remote assessments, and offer
demonstrations, training, and assistive technology for education, work, and daily
living environments.

Accessibility Compliance Consultations focus on the accessibility needs of
organizations, offering technical assistance, customer support, and evaluation of
overall website accessibility.



Format

E-Text Products I AMAC
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Description of Accessible Features

PDF

PDF files that retain the same layout as the print textbook and include bookmarks for navigation, synchronized
highlighting of text, and can be read aloud by screen readers. Students can easily magnify the text or change
color contrast options. Images do not have alt text descriptions.

MS Word Doc

DOCs are best for students who use screen reading software such as JAWS and are formatted in a single
column layout. Three levels of headings and page numbers are included, reading order is determined
manually, and alt text descriptions are provided for all images except for decorative images and images with
adequate captions.

DAISY

DAISY files are read by Dolphin EasyReader, which has a wide range of voices. These files have three levels of
headings, correct reading order, and alt text descriptions are provided for all images except for decorative
images and images with adequate captions.

PowerPoint

Each PowerPoint slide has a unique descriptive title, all images and tables are fully described, and the reading
order is determined for all objects on the slide. Also, all content will be placed in accessible content boxes that
will be read aloud by screen readers.

HTML

HTML files have three levels of headings that provide navigation, reading order is determined, and alt text
descriptions are provided for all images except for decorative images and images with adequate captions.

MathML

MathML files include all the features of our accessible HTML files, plus all equations and symbols are
accessible to screen readers and are pronounced according to MathSpeak guidelines.

Audiobooks

Books are downloaded and read with Learning Ally software. These files are audio only, but are read aloud
with human narration, not synthetic speech.




Who Uses Accessible Media l AMAC

ACCESSIBILITY

The audience for Accessible Media is not just people with disabilities. It
is far larger than you would imagine...

People who have blindness, color blindness, or low vision
People with mobility issues who cannot hold a textbook
People with motor disabilities who cannot turn pages

The Deaf and Hard of Hearing Community

People with learning disabilities such as dyslexia or ADHD
People with head injuries, trauma, or cognitive disabilities
Auditory learners

Aging population



Why Accessibility Is Best Practice I\ AmAC

ACCESSIBILITY

Making material accessible is best practice ethically,
practically, and legally.

Making material accessible allows for equity and fairness in information
distribution and opportunities.

Accessible files can be converted into multiple file formats easily and can
reach more people.

WCAG 2.0 stands for Web Content Accessibility Guidelines. Following these
guidelines protects you from litigation.

The United States Department of Justice recommends the ADA Compliance
Guidelines for ICT Accessibility.

Section 508 Guidelines are determined by the GSA, the Government-wide
Section 508 Accessibility Program.



Microsoft Word Accessibility

Choosing accessible fonts and design features.
Creating white space.

Creating and modifying headings.

Generating an automated table of contents.

Creating accessible lists.

Establishing a logical reading order.

Formatting accessible tables.

Using column breaks, section breaks, and page breaks.

O 0 N WUL kA WDNRE

Writing alternate text descriptions for images.
10. Using the accessibility report.

I AMAC

ACCESSIBILITY

ws



Accessible Fonts l AMAC

ACCESSIBILITY

e Use font sizes between 12 and 18 points for body text.

* Use standard fonts with clear spacing and easily recognized upper and
lower case characters. The following fonts are the most accessible:
Calibri, Arial, Verdana, Tahoma, and Times New Roman.

* Sans serif fonts (e.g., Calibri, Arial, Verdana) are generally considered
easier to read than serif fonts (e.g., Times New Roman, Garamond).

e Avoid large amounts of italicized, bold, or underlined text. Text in all
caps is also difficult to read and produces eye strain.



Accessible Design Features I\ AMAC

ACCESSIBILITY

Try to use plain text whenever possible, avoiding unnecessary tables, borders, or
graphics if they do not convey meaning.

*Use normal or expanded character spacing, rather than condensed spacing.

Use language that is clear, direct, and easy to understand.
Explain all acronyms, symbols, and abbreviations.

Provide meaningful context for all hyperlinks.



I AMAC

ACCESSIBILITY

Color Contrast

Provide sufficient color contrast between text and background colors. Do not use color as
the sole means of communicating information such as required fields and error

messages.

Text should be easy to read.

* Color contrast in comparison to the background should be a ratio of 4.5:1.

* A good tool to test the color contrast is Colour Contrast Analyser found at The
Paciello Group (www.paciellogroup.com).



https://github.com/ThePacielloGroup/CCA-Win/releases/

Creating White Space /ccgé\s',\gﬁg

When creating white space in your document,

DO NOT:

Hit Enter, Tab, or Spacebar more than once.

DO:
Use line spacing.
Use tab stops.



Viewing Repeated Blank Characters I\ AMAC

ACCESSIBILITY

To see the blank characters, turn on Show/Hide
paragraph marks.

You only need to fix the repeated occurrences. It
is fine to have one blank character per
occurrence.

REFERENCES MAILINGS REVIEW  VIE

= .. ez 3= | A

1

ra- by i
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Repeated Blank Characters

Repeated blank characters are caused by hitting enter,
tab, or space multiple times in a row.

A screen-reader may say the word, “paragraph mark,” or
“blank space,” or “tab,” for each of these blank
characters, which could confuse the listener.

Course-Placementy
Beginning-fall-2012, test-scores-will-be-required -for-all-freshman-applicants.-Stud
before-an-admissions-decision-can-be-made. The-testing requirement-can-be-sat
scores-on-1-of-3tests:q

1

5 Repeated
q ‘ \ Enters and Tabs
1.+ Minimum-SAT-Scores:

Critical-Reading -+ - -+ 4809
Math -+ -+ -+ 4607




Using Line Spacing I\ AMAC

ACCESSIBILITY

Put your cursor either before or after the word where
you want white space.

Use the Line Spacing option in the Page Layout tab and
add space before or after the word as seen below.

Delete any repeated hard line breaks.

PAGE LAYOUT REFEREMNCES MAILINGS REVIEW
aks - Indent Spacing
*Numbers = 3= Left: |0" i IE Before: |0 pt
thenation~ =& Right: |0" A 2= After: |8 pt

P



Use Tab Stop Instead of Multiple Tabs I\ AmAC

ACCESSIBILITY

A tab stop is a horizontal position which is set for placing
and aligning text on a page.

First you must view click the View tab and check the box for
Ruler, as seen below.

DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW = VIEW

- q |:E’ EE| One Page DE E e

Gridlines E EE Muttiple Pages
com  100%

MNew Arrange 5Split
rPage Width  window Al

Zoom

Mavigation Pane

Show
The ruleris |

5 1
now visible. B



I AMAC

ACCESSIBILITY

Using Tab Stop

Click on the ruler where you want your tab to stop.

Then hit Tab in the designated section. (Hint: you can
drag the tab stop if you need to.)

A4 5 6
. Minimum SAT Scores: @ & Click on the ruler where you

Critical Reading k180

want the tab to stop.

Math 460
" Eﬁ":-m:m ACT Scores: 21 Place your cursor after the word
nglis . h
Math 19 Reading and hit tab.

. Required Minimum COMPASS scores:

English 32
Reading 62
Math 20

The number 480 stops right
where you specified.
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ACCESSIBILITY

Adding Headings

View EasyProducer Add-Ins Acrobat

= ALq % Harne
EE 7 AaBbCcDc  AaBbCeDc | AaBbCi | AaBbCc | 3 Replace
+ac

Sy - 0 T Hormal TN " | Heading1 | Heading2 — Change
— g g 7| Styles = Ly Select -
. Styles 1 Editing

Heading levels help users navigate and they also help
you organize your content. Instead of making your
headings look a certain way, and instead focus on how
they function.

Screen reader users can use quick key commands or
shortcuts to navigate documents by Heading levels.

* Your headings will retain your document structure
when exporting to different file formats.
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Navigation Pane

Click the View Tab and check the Navigation Pane box to
view all the headings in the document.

FILE HOME INSERT DESIGN PAGE LAYOUT REFERENCES MAILINGS REVIEW @

Eﬂ D %ﬁgg::tne Ruler q | One Page DE E E

Gridlines EE Multiple Pages

Read Print Web = - Zoom 100% ) Mew Arrange Spl
Mode Layout Layout Navigation Pane & Page Width Window  All

Views Show Zoom
Navigation T
SR o- ‘Dual enrollment and Un

and practices
HEADINGS  PAGES RESULTS

= February 2016
Dual enroliment and University System of Georgi... The University System of Georgis
. 1 . 1 .~ .
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Heading Styles

Highlight some text and choose the Heading style
from the Home Tab and your heading will show up in
the Navigation Pane on the left.

NOML  IMSCRT  DCSKA PASCLAYOUT  CFORCHCLS  MAILNGS  ROVIDW  WIDW  Malilype  focsssitile A
- . _— . - - A L —— L)
r Colibiilight {- |16 | & & Aa- @ i=-a=-72- &8 8 7 e aeBbCend | AaBhi

P ot oy | B f M e w - WAL IS= == oo & -F- | tHemal vHespec. |Heade

Lk 3 url T Parairazh L
= 01 a1 M
r‘-\.-:-"."l'-._;f-.lt.-l
[ >

Dual enrallment and Universily System ol Ge

and praclices
HEADINGS Pivabs RESULTS
L February 2016

Lual enrcliment and Lineersiby System of Geong.. The University System of Georgia (D5G] is comprised of multi
rreale i more edumted Georgia while also retaining individo
nf the I8G are rategarized into different sectorst hased on fac
Ly the institution, extent to which the institution engages in r
seloctivity.
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Customized Headings

Heading styles can also be

PLANOLT  REFEREMCEE MAILINGE RAFVEA WIPY  Acceshitty  AREYY Fneflesderil  ACAORAT

customized, so you can keep &y T ESn B e v
style options while also

adding meaningful structure
for screen reader users.

Right click on a Heading Style
on the Home Tab and then
select Modify Style to adjust
your formatting options.

i Lipl
comih frad, KEep lives Togetre, Lews 4, Style: Linked, S in e Siske:

7 Aadu b thee Ses galbey [ Bglomalicaly ugsole
1enls base




Automated Table of Contents

I AMAC

ACCESSIBILITY

Once you've applied heading styles, you can insert
your table of contents by clicking the References
tab and then the Table of Contents command.

Select a built-in table of contents.

m:| k= s complete_being edited_

HOME ~INSERT  DESIGN  PAGE LAYOUT n

1 | Add Text - 1 Uy Insert Endnate

&L Manag:

¥

| Update Tahle AR Next Foatnate - & style: [¢

Inzert Insest . Gilbl
Fonmote Citation = - 0y
> s & Rikling
; Trainng GG
Automatic Table 1 Providing da
Corprmumical
Conbenis Engiing e
L [ — S —— e PEsisling i

uuuuuu

' DATA STE



Updating the Table of Contents I\ AmAC

ACCESSIBILITY

The TOC is automatically updated When you update the TOC, you

whenever you open the will choose to update the entire
document. TOC, or just the page numbers.
You update the TOC by clicking  Only edit the headings within the
the References tab and then body of the document, not in the

Update Table, in the Table of table of contents itself.
Contents group.

HOME  INSERT 4# DESIGN PAGE LAYOUT  REFERENCES

> T Add Text - 1 Gt )
ri] Insert Endnote i 4 Mar
AB Y 2

[l Update Table A Next Footnote ~ g sty
Table of Insert Insert

Contents ~ Footnote = Show Notes Citation - & [1BibI

Table of Contents Footnotes I Citations & Bik



Creating Accessible Lists I\ AMAC

ACCESSIBILITY

Using list styles will identify to a screen reader that there is a
list and the number of items in the list.

Using list styles will also preserve list formatting when
exporting a file to another format.

Use Word’s list builder to create true lists rather than
creating your own lists with icons or graphics as bullets.

e Use theicons in the Paragraph group on the Home
tab.

 When you select a bullet or number, the entire list of
bullets and numbers will become selected = true list.

e Use the icons to adjust your list styles and
hierarchies.



List Options I\ AMAC

ACCESSIBILITY

DESIGN PAGE LAYOUT  REFEREMCES MAILINGS REVIEW  VIEW  MathType Accessibi

ra -0 -|A A Aa- ﬁl T AaBbccDd AaBbCcDd A

I U -abe x, X° /A - =E=E = = O~ T Normal T No Spac... H

Font P Paragraph 1

4 Carnegie units of college preparatory English
4 Carnegie units of college preparatory math
e 4 Carnegie units of college preparatory science

« 3 Carnegie units of college preparatory social science

« 2 Carnegie units of the same foreign language, or 2 units of American Sign



Reading Order, Part 2 I\ AMAC

ACCESSIBILITY

Avoid too many sidebars and callouts that will
sound disruptive and confuse someone using a
screen reader if possible.

You should not span a sentence to the next line for
visual purposes if there is other text that will
interrupt it.

Instead, create a table or another column.

+
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.+ 1604
+ 1809
= 2009

k4
844
A )



Accessible Tables I AMAC

ACCESSIBILITY

Tables should:

Have a specified header row.
Have a logical reading order from left to right, top to bottom.
Contain related information.

Consist of the same number of cells per row/column (not
merged cells).

Have a title and caption that gives an overview of what’s inside
the table. If placed before the table, it can help the person
using screen reading software to focus and interpret the data.



Avolid Merged and Empty Cells

Do not merge cells.

Merged cells do not
provide clear information
to a person with print-
related disabilities.

Each row and column

MUST have the same

number of cells as the
others.

Avoid leaving any cells
blank/empty.

i Lasaad Altre lo

r L

foohlasn arvat e o Trdd, Lhieek mul of hatel bdue: BLY am

{3 TR E Sk e Pl b m s and dnee o oy o v sl e "
1'ark. 11 Area #E Wiilur Lol

ezl Wolven: Addros I ST R AR PR

CE T H

[RTERE

25 2ok Bod Pelirn, e ol deonps Sk
Wth e Faan, Gevae Fech S0a Mo

S B I Sthehes. B0 St AE
e G TELh MRS

i oryea Tonk Sl Ereruties Cakine
Daven T84

SGh Ml Hee™

P Traral
ATe beTrum nk PP Shidsnbhor of nas Sarofe Taz= sy =

D2 e bavak

Haam = 20 pm

[ezrin A5k Luabodg Laids”
zowdo H b poppbedus 413 0kan

HEE TS T T .

|Sredan 214 Lrst Crel ok tra Yasr Raserk
Siewnc i Ui Hae G Regionisd Linbarebee
SIEIE N e

B T

AR e

oo 2o U e

M pm, —800 0w,

i = ST,

= Fraryssnks Bor Eind of Ve Bt

ISr=edan 5k Fsnnatioe] from Arssrok Seed -
ol o wdectedd chidentk B sech nmin

i ek WA Ak nr

Lunfloroi: Wrap We vy oo SAL Leaderdup Svanl
drLoFar b, Fer AT

- Frer Ul (s Moo s
el ":_=anve = apart ok ik b,
[Diiee Home Safely

I AMAC

ACCESSIBILITY



Empty Cells in Tables I\ AMAC

ACCESSIBILITY

Upeoaming Events

— The way this is currently
- wee . . configured, a screen

£ reader would treat this
I as a table with rows,

o T B R most of which are blank.
s wow a a__w=— »  Alistof all events might
see == work better, or consider
== adding “No events
ma e g planned on this day” in
== empty cells.

.......



Table Header Rows I AMAC

ACCESSIBILITY

Organize a table so that the
table has only one header row.

; i Professional Attire for Entire Day with School Pin & Nam
ilD:SD a.m. — 10:55 a.m. ERegistraL‘inn at Hampton Inn — Park in GT Area #1 Yisitor Lot
511 00 a.m . :Meet in hotel lobby for bus transport b B.OR sharp
- H Two —
i iWelcome from the Chancellor i
| : header |
511 30 a.m . ~12:30 p.m. i{session #1): Chancellor Hank Huckaby rows Room 5158 ¢
: Guest Regent Lori Durden, other USG staff :
512:30 pm — 1:00 pm ELunch at BOR's office Room 5158 ;

! E(Sessinn #23: "welcame to Capikal Hill™
; iSpeakers: Amanda Seals & Tom Daniel, Legisiative Affairs ;



Specify Header Row I\ AMAC

ACCESSIBILITY

To properly specify the header row, first select the
table.

Then click the Design Tab.
Now check the box for Header Row.

Your first row now becomes a Header Row.

EHs : Lzameant] - W
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Eliminating Header Row Errors I\ AMAC

ACCESSIBILITY

If you still have errors in the accessibility report
about not having specified a header row, click on
the table, then go to the Table Layout ribbon,
and select “Repeat Header Rows.”

ty Check Design Layout

== = — . [ = | \=

ht: 0,22 2 HE vistribute Rows === E | Ej =3
55208 —

h: 161" * X Distribute Columns — Text Cell Repeat

= = Direction Margins
Cell Size Alignment




I AMAC

ACCESSIBILITY

Keep Table Rows Together

If the table spans more than one page, make sure that
“Allow row to break across pages” is unchecked.

Right click the table and click Table Properties. Choose the
Row tab and uncheck Allow row to break across pages.

slg g als

5 B}




Repeat Header Rows

If the table spans more
than one page, make sure
that you check the
selection to repeat the
header row for each page.

*Select the first row of the
table, right click, and
choose Table Properties.

*Check the box for
“Repeat as header row at
top of each page.”
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Layout Tables

Do not use tables for layout purposes
only.

Tables have to have logically related
information with a header row.

You cannot format content into a
table just to make it look nice. Tables
are not intended to be used for lists,
groups of words, or visual purposes
only.

If you want to format content like a
table, then use column breaks,
section breaks, page breaks, or tab
stops.

I AMAC

ACCESSIBILITY

Screen readers read
information across 1
This is a layout
ina linear y table. There is
no header row |
thereb makin i| and no clear
¥ g classification of |
difficult to the words.
informatian contained T
Layout table:
H - Business Casual Attire for D ay] Does not
H EEreakFast available at hotel, Check out of hotel before 8  have a clear
i6:00 a.m. — 8:00 a.m. iParticipants put luggage in cars and drive ko Georgia Tech header row
: : Parkin which
: EPresident's Welcome Address Student 9 identifies
W30 aam, — 9115 aam., :
H iwelcome video what each
; column
*President Bud Petersan, President of Georgia Tech represents
EN\chnIas Picon, Georgia Tech 5GA President . )
:0r. Bill Schafer, VP for Student Affars This table
H i Cther Georgia Tech administrators was created
1915 am. - 9:35 a.m. H :
H L Georgia Tech 5GA Executive Cabinet for visual
 Video, @ & A puUrposes.

{9:35 am. - 10:45 am.

i“ Tour of SGA Office™ H
Tour of CULC™ Student tour of new Georgia Tech academ ic Facility cuLc

i~ 15 min. break -




Column, Section, and Page Breaks I\ AmAC

ACCESSIBILITY

Only adjust spacing using page layout, line spacing,
section breaks, and ruler. Do not hit enter or tab
repeatedly to create white space.

Create columns with Microsoft Word’s formatting tools,
not by tabbing or creating a makeshift table to arrange
text.

Inserting section breaks and adjusting your margins can
help you change the layout of your page if necessary.



I AMAC
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Using Section Breaks

If you want to format a certain section of the document:

Turn on show/hide paragraph marks.
Place your cursor before the section you are formatting.
Click the Layout Tab> Breaks> Section Breaks Continuous.

Then insert another section break after the section. Within the
two section breaks, you can format the text however you wish
and this formatting will not affect the rest of your document.

| — P — B 0] -1 1= [ A1 1 S ————— R ———
Strungly Disagree Mautral Agree.... Strungly'ﬂ
Disagree- - AQree. -.--



Unclear Hyperlinks I\ AMAC

ACCESSIBILITY

Often the Accessibility Checker will flag hyperlinks in your document.
To create fully functional and accessible links, do the following:

1. Write the name of link in plain language, ie. The Department of
Natural Resources News Site.

Highlight the name of the link and right click to Insert a Hyperlink.
Paste the URL in so that the title turns into a clickable link.

Add the URL in parentheses after your hyperlink for print
audiences, and right click to remove the hyperlink from the URL.

Example: To learn more about our educational programs, workshops,
classes, and events, please visit The Department of Natural Resources
Education website (www.gadnr.org/education).



http://www.gadnr.org/education

Alternate Text Descriptions I\ AMAC

ACCESSIBILITY

All images in a document should be fully

described so that everyone has equal access to

visual information. Remember to use proper

capitalization, grammar, spacing, and

punctuation. S | romat e

To add alt text to an image:

* Right-click the image.

* Choose Format Picture.

* Select the Layout Properties icon. :
* Click on the Alt Text link. i
* Type in the description field.
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An Example of Alt Text Description

Growing Population Diversity

Brief: A bar graph showing projected population diversity growth by ethnicity in the years 2010, 2020, and 2050.
Ethnicities measured include White/Non-Hispanic, Hispanic, African American, and Asian and Pacific Islander.

Complete: A grouped bar graph showing the growing population diversity in 2010, 2020, and 2050. The horizontal axis
is labeled with different ethnicities and the vertical axis is labeled with percentages from zero to seventy. In 2010, the
percentage of white non-Hispanics was 65 percent, and is estimated to be 60 percent in 2020 and 46 percent in 2050.
In 2010, the percentage of Hispanics was 16 percent, and is estimated to be 19 percent in 2020 and 30 percent in
2050. In 2010, the percentage of African Americans was 13 percent, and is estimated to remain at 13 percent in both
2020 and 2050. In 2010, the percentage of Asians and Pacific Islanders was 5 percent, and is estimated to be 6 percent
in 2020 and 8 percent in 2050.



Adding Metadata

By clicking on the File tab
and viewing the
Document Properties, you
can edit information such
as Author, Title, Subject
Tags, or Comments to
provide further
information about what
the document contains.
This data will be retained
if you save as an
accessible PDF.

Properties ~

Size 25.9KB

Pages 1

Words 60

Total Editing Time 25 Minutes

Title Moving AHEAD Conference
Tags

Comments

Related Dates

Last Modified Today, 10:40 AM
Created Today, 10:14 AM
Last Printed

Related People
Author Maorrison, Valerie Mandeville
Last Modified By Maorrison, Valerie Mandeville

Related Documents

Bl Cpen File Location

Show All Properties

I AMAC
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Check Accessibility /CCE@;,\Q,ﬁg

Save your document as a .docx file.

Go to the File tab and click on Check for Issues, and
select Check Accessibility.

The accessibility checker will open in a separate pane
and list all accessibility issues with links to each
potential problem.

Additional information appears below, instructing
you on why this might cause a problem and how to
fix the issue.
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Finding and Fixing Errors

Accessibilily Checke
Irspection Results

Click the
error

FRRXIRS
A Missipg A0 Teal
Takle
Mo Header Roar Specihied (2]
WARNDGS
Infrequent Hesdings (18] Additional
» Merged ar Spi Cels (101 Information is
Unicdear Hypardink Text (173 provided
} about wiy to
Heauding is Too Loeg () fix and how to
Repested Dlank Charscbers [LS1) fix this emror.
TIPS
Chesck, Raandingy Chedey (LT
Additional Informetson w

ARPMars fret helps madss anderstand infamehion
preserked in protures and ather obgects.

Tar add alerans 1ex7 To & table

Select and ho =ach issus lsted abave to make this doourmend
ucessible for pesple with abililies

S e ]

Read mnne abou making i
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Saving Your File as an Accessible PDF

MS Word 2010 includes the option to Save and Export accessible formatting including
headings and alt text when the doc is saved as a PDF.

To export your Word doc to an accessible PDF format, go to File > Save As >
from the Save as type drop down menu choose PDF and click on Options.

File name: Tips for a More Accessible M5 Word Doc source

Save as type: | PDF

Authors: AMAC Tags: accessibility

Optimize for: @ Standard (publishing ’ Options..
enline and printing)

& Minimurm size [#] Open file after publishing
] (publishing enline)



Accessible PDF Options I\ AmAC
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From the PDF Options menu, under Include non-

. . . . . jons ? 9
printing information, be sure to check the following =
. Page range
options: ou
() Current page
* Create bookmarks using Headings P
* Document properties Pubish what
@ Document
* Document structure tags for accessibility Document shoving mar.p

Incdude non-printing information
Create bookmarks using:
@ Headings
Word bookmarks
Document properties
Document structure tags for accessibility
PDF options
[ 150 19005-1 compliant (POF/&)
Bitmap text when fonts may not be embedded
[ Encrypt the document with a password

K ] [ Cancel




PDF Accessibility I\ AmAC

ACCESSIBILITY

Text highlights in proper reading order.

Bookmarks provide structure and organization.
Pagination is clear and navigable.

File size is manageable, under 25 MB is ideal.

File names are clear and contain no symbols.
Images have alt text descriptions if necessary.
Language and metadata are included in properties.

N o U AEWNRE

®

PDF
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Adding Bookmarks to a PDF

PDFs should have bookmarks to help a Table ot cantanes
user easily navigate to different sections of " s
the file. P
Bookmarks can be generated from a Word m:m SR
document with headings, or you can add T
them directly into your PDF by highlighting

text and clicking Control + B or right it
clicking and choosing “Add Bookmark.”




Bookmark Hierarchy

Bookmarks can have different
hierarchies for organizational
purposes.

To adjust the hierarchy of your
bookmarks, drag them up and under
the “parent bookmark” so they
appear indented.

I AMAC
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Bookmarks X
—i
E' Dﬂ 1-H-b

=i ﬂ Acing Business Associations: A Checklist
Approach to Business Associations

[:| Acknowledgements
[] Table of Contents
[] Introduction
E] Chapter 1: Agency
u Chapter 2: General Partnerships

u Chapter 3: The Structure of the Corporation
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Reducing PDF File Size

To reduce a PDF’s file size you can try either of the following methods:

1. Save your PDF as a reduced file size. Go to FILE, select “Save As Other”,
and select “Reduced Size PDF.” When prompted to select Acrobat Version
Compatibility, select “Acrobat 9.0 or later” from the dropdown menu.

2. Split the file into smaller sections, naming each section clearly.
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File Naming Conventions

Keep titles short and simple and under 50 characters if possible.
Do not include symbols, suchas/:-& % ) #
If you split a PDF into separate files, name each section clearly.



Adding Alt Text to PDF Files I\ AMAC

ACCESSIBILITY

To add alt text descriptions to images in a PDF file, it’s easiest to turn on T.U.R.O. in
the Accessibility Tools, which stands for “Touch Up Reading Order.” This highlights
all figures for you, and you can then right click on the ones needing descriptions
and select “Edit Alternative Text.”




Inaccessible PDF Forms I AMAC
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e
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HLL MATERIAL ERCIHE DANVE TrPE| FLEL WEESEL TYPE (Chek Dvech PERATEIH | C ks G FEFLSINN TVPE]
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This Vessel Registration Application would be very confusing for
someone using a screen reader to navigate and edit. It could be
remediated, but each check box would need to be individually
formatted with alt text descriptions.



Accessible HTML Forms
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GEORGIA DEPARTMENT OF NATURAL RESOURCES
#% GEORGIA APPLICATION FOR EMPLOYMENT

An Equal Opportunity Employer

DEPARTMENT OF NATURAL RESOURCES

EDUCATION:

High School Graduate or Equivalent (GED)?  [Yes OONo
College / Technical School | Program
Institution City/State Major Hours | Minor Hours | Type of | Date Degree

Degree | Completed

/

/
/
/

The PDF form above could easily be rendered as a table in
HTML format, keeping the same content and format, and
it would be easier for a person using a screen reader to
navigate and edit. Employment forms would be a top
priority in conversion, followed by forms on frequently
visited pages, and landing or home pages.



Accessibility Report

You can also generate an
Accessibility Report in the
Accessibility Tools
options. Click on “Full
Check” to open a list of
things you'd like your
check to include, such as
figures missing alt text,
missing bookmarks,
errors in reading order,
color contrast, not having
a language selected, etc.

Aoerri bil by Checker Options

I AMAC

ACCESSIBILITY

%)

Repunt Dplices

#| Create accessbil by regort Foldzn ChUsessiwmen senbiDoouments

Allazh ngeert o document

Payu Range

& &l prges in document Pagesfrom |32 o [

Checking Dptions (31 of 32 n all cotegenies)

Calsgury: | Documrent

7] Arcascikiliy permision Slag = oet

F] Darumant i not imaga-zmiy FOF

#| Dorumrent & tagged PLF

#| Documrent struckune provides a legical reeding ander
] Tacet Larvgusagym s sps fiend

M Docurrant 1itle k showing in tithe bar

#| Bcokenarks are present in farge decuments

#| Docurent has sppropiate color contrst

St Al Cheer Al

[ Show this cislog wher the Checksr stams

Help |

| Skart Checking |

hoose..

Cance




Excel Accessibility I\ AmAC
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1. Consider design and formatting in terms of clarity.

2. Each sheet tab should have its own unique name.

3. If contentis in table format, include clear column and row
headings whenever possible.

4. Do not merge cells or leave table cells blank.
5. Bulleted and numbered lists are created properly.

6. Graphics, smart art, charts, shapes, and tables are described
with alternate text descriptions.




Unique Names for Each Sheet I\ AmAC

ACCESSIBILITY

Each Excel sheet should have its own unique name for easy navigation.
In addition, all empty sheet tabs should be deleted to avoid confusion.

24 |
25

| 2|

| Vendor Invoice |(Sheet2 | Sheet3) (@




Structural Alt Text for Tables I AMAC
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In addition to adding alt text descriptions
for any images or visual content, consider

adding structural alt text to summarize P:f'cg_l F’Fl:lpl:llerTIEE
L nE
your table contents. This gives someone a orthe blantHanets
chance to hear what the table contains Jupiter | Satum | Uranus | Neptune
before listening to all the data. e B @ 0
Drbital period | Earth 119 205 A4.0 164.8
Example: s
Dviital velocity (kmya) 13.1 9.7 6.8 54
Table 10.1 is titled Physical Properties of Mass (M., = ) 3178 05 145 17
the Giant Planets. It has 5 columns and cohrilimcheim 71450 60270 15560 24300
. Equatorial radius 11.2 a5 4.0 38
13 rows. The column headings are (A = 1)
Physical Property, Jupiter, Saturn, Uranus, cristeness DO6S DO DU oqW
Diensity {watar = 1) 1.33 .69 1.27 L4
and Neptu ne. Ratation period (hours) o0 10.7 172 16.0
Tilt (dagrees) 3.13 26.7 Lk, 3 28.3
*Please note that because the first column heading Surtace gravity 253 L7 0.89 L4
was left blank, we filled it in so that the table would iralative to Earth's) _
Escape speed (kmy/s) 595 355 213 235

make more sense.




I AMAC
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Accessibility Checker in Excel

Accessibility Checker ™ *

Inspection Results

ERRORS

s s Use the Accessibility Checker in

i Microsoft Excel, just as you would in

WARNINGS Microsoft Word. Go to File, then click

et on Check Issues, and then Check
Accessibility to run a quick report
listing issues you need to fix.

Additional Information v

Select and fix each issue listed above to
make this document accessible for
people with disabilities,

Read mare about making documents

accessible



PowerPoint Accessibility I\ AmAC
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ACCESSIBILITY

Consider design and formatting in terms of clarity.

Add content by using accessible Templates and Layouts.

Slide titles are unique, descriptive, and in a logical order.

Select proper reading order for objects on each slide

Text is accessible to screen reading software in outline view.

Extra white space is eliminated in outline view.

Bulleted and numbered lists are created properly.

Graphics are described with alternate text descriptions.
./_Pj

-

——



Clear Design and Format I\ AMAC

ACCESSIBILITY

Fonts - use a readable font in a large enough size that your presentation
will be seen throughout the room.

Backgrounds - Always place text on a plain or solid background.

Inserting a background image allows you to include graphics that are not
read aloud by screen reading software. For example, the AMAC logo
above is simply a background image.

Colors and contrast - text color should provide enough contrast with
background color that people can easily read it. Readers with low
vision read yellow font on a black background most easily.

* Layout - use a standard layout template with text placeholders. This
will help with logical reading order and make sure that all of your
content will be accessible.



Templates and Layouts I\ AMAC

ACCESSIBILITY

Use PowerPoint’s built-
in templates, not the

P, Qeiiis ;
text boxes which can be B = e g e i i B
inaccessible to screen L s
readers. 2, I | g
*Go to Home Ribbon i
*Click on Layout : = e |
*Right clicking on the .

slide pulls up layout A T . T A
options, as well.



Unique and Descriptive Slide Titles I\ AmAC

ACCESSIBILITY

Give each slide a unique title
 Aids in navigation
 Clarifies your presentation
« Organizes your ideas
« Helps your audience focus



I AMAC

ACCESSIBILITY

Selecting Reading Order

Go to menu item: Home

epe . . Selecti d Visibili v X

In the Editing section, select Select > Selection ection end TRy

Shapes on this Slide:

Pane... Picture 16 [=]
In the Selection pane, all the elements on the Picture 13 [=
slide are listed in reverse order. In other words, Content Placeholder 8 [=]
the tab order of objects begins at the bottom of Text Placeholder 5 =i
Title 1 [=]

the list and tabs upwards.

Elements can be re-ordered using the arrows at
the bottom of the Selection and Visibility pane.
Note how many objects are in this example
screenshot. It would be more accessible if the
slide were simplified and streamlined with fewer
objects if possible.



Outline View I AMAC

ACCESSIBILITY

Check that text appears in the cipbora 5| sides Font
Outline View (View tab>Outline M‘_diﬂ"ﬂﬁwt ;
View) 3 f\:dt?;tlt text to images

If accessible templates and proper et Format et

content placeholders have been e sty ol ton mthe desonpton enty area. | |
used, the text will be viewable inthe |, .

outline view. If text boxes were used ¢ e bullted s

on the slides, screen reading .+ Conces

software might skip this text. " Concet

Delete extra hard line breaks in the L. ttem 1

outline view when possible. These S tom 3

will be read as “blank line.”



Inserting Tables I\ AMAC

ACCESSIBILITY

To add a table with headings
* Go to menuitem: Insert

* |n the Tables section, select the Tables icon

* Select the number of rows and columns you would like your table to have

* Select the table and a Table Tools menu item should appear

* Go to menu item: Table Tools > Design

* Inthe Table Style Options section, select the Header Row check box

* Note: Whenever possible, keep tables simple with just 1 row of headings.

* Add a brief description before table if possible, to give an overview of data.

ID Institution Type Eligible Pld9-as
Home Insert Design Transitions
24 Emory Post-doctorate yes Header Row [] First Column ==
[ Total Row [ Last Column EE— == |
77 UGA Undergraduate yes Banded Rows [ || Banded Columns —

Table Style Options

82 Georgia Tech | Undergraduate yes




Select Lists Styles I\ AmAC

ACCESSIBILITY

Create bulleted and numbered lists with the
built-in list tools.

The Home tab has drop down menus where
you can easily create lists and adjust their
hierarchy.

Avoid creating a list with icons or graphics
as bullets.



I AMAC
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Considering Graphics

If most of your images are decorative, can you
combine them into one?

If your slide contains an animation, can you include a
text description that sums up the main content?

Do your graphics appear crisp and legible?

Can your information be conveyed in a different format
either instead or in addition to your graphic?

To determine the alt text to add, determine the
purpose and meaning of the image and write a brief
text equivalent.



Using the Accessibility Checker I\ AMAC
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To access the Accessibility Checker, go to the File tab and click
Check for Issues

From the drop down menu, select Check Accessibility

Prepare for Sharing

[(Pas Before sharing this file, be aware that it contains:
= Document properties, author's name and cropped out image data
Check for Foot
Issues ~ noters

Content that people with disabilities are unable to read

Prepare for Sharing
Before thanng the fie, &

X Oocument properles author's name and Copped Out image ']
Chech for
e £oot:

gt Document

Chech Acceswbaty

wlh S aniie Wt 1id ST 1o resd

W] 3 Check Compatiniay

.\A hech Por features ot Lupported by eaflier
veruons of 1




Save Your Presentation as an Accessible

PDF écgé\!.\é‘.ﬁ%

MS PowerPoint 2010 and 2013 include the option to Save and
Export accessible formatting, including alt text when the ppt is
saved as a PDF. To export your file to an accessible PDF format,
go to File > Save As >

from the Save as type drop down menu choose PDF and click on
Options.
Under Include Non-Printing Information, be sure to check:
* Document properties
* Document structure tags for accessibility
If Adobe Acrobat PDF Maker is installed, choose Save as Adobe

PDF. An important advantage to exporting with Adobe PDF
Maker — slide titles will export as Bookmarks in the PDF.



Captioning Services I\ AMAC

ACCESSIBILITY

Students may request live or remote captioning
through Disability Services.

In addition, captioning is required for all video
content in a classroom or posted online.

All videos should be transcribed accurately, with all
visuals described, including all sound effects and
speaker identification.

YouTube captioning does work, but it must be
edited. You can extract the YouTube transcript and
edit it, or write a transcript yourself.



Audio Description I\ AmAC

ACCESSIBILITY

Audio description refers to an additional narration track
intended primarily (but not only) for visually impaired
consumers of visual media. Options include the following:

1. Provide a separate audio track which contains a brief
description that can be selected by the viewer (ie. Netflix).

2. Create a separate video with extended description merged
into the original audio track. This extends the length of the
video and provides more detail (ie. what AMAC provides)

3. Provide a script that includes a transcript of all audio plus
description of what is onscreen.

4. Avoid the need for audio description by describing all visual
information in the original video.



I AMAC
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Accessibility Checklists

m |
You can find helpful 2 Checklist: PDF File
508 ChECinStS for .w.J Checklist: Word Document
various flle types on X‘fA] Checklist: Excel Document
the U.S. Department P .

——1 Checklist: PowerPoint Document
of Health and Human =

»  Checklist: HTML File

Services website

(www.hhs.gov/web/section-
508/making-files-
accessible/checklist).

““| Checklist: Multimedia File


http://www.hhs.gov/web/section-508/making-files-accessible/checklist/

I AMAC
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AMAC Accessibility Memberships

AMAC accessibility services can be accessed by becoming an AMAC member.

We offer a range of membership levels, each designed to meet the particular accessibility needs of
different types of organizations.

Membership Levels

There are five AMAC Accessibility membership levels:
The Basic and Deluxe memberships are designed for post-secondary institutions.

The Corporate, Government, and Non-Profit (CGN) memberships are designed to support companies
and organizations in their efforts to accommodate employees, clients, and customers with
disabilities.

The Georgia Board of Regents (BOR) post-secondary membership is designed specifically for
institutions, departments and affiliates within the University System of Georgia.

The Assistive Technology (AT) membership is designed for individuals who are not part of an
organization and only require AT evaluation services.

Feel free to visit our membership website for more information or contact Sam Evans, our Accounts
Manager, at sam.evans@amac.gatech.edu or 404-894-8683.



http://amacusg.gatech.edu/wiki/index.php/Basic_Membership
http://amacusg.gatech.edu/wiki/index.php/Deluxe_Membership
http://amacusg.gatech.edu/wiki/index.php/CGN_Membership
http://amacusg.gatech.edu/wiki/index.php/Assistive_Technology_Assessment:_AMAC_TechMatch
http://www.amacusg.org/membership.php
mailto:sam.evans@amac.gatech.edu

AMAC’s Accessibility MOOC I\ AMAC

ACCESSIBILITY

About this course:

In this introductory course, learn how to measure an organization’s ICT accessibility and assess the importance of maintaining an
inclusive workplace for both employees and customers with disabilities. This self-paced course consists of six modules detailing
some of the primary ICT accessibility obstacles facing organizations today. Each module is taught by a subject matter expert —
through content-rich videos, activities, and discussion forums.

What you'll learn

Foundations of ICT accessibility.

Principles of accessible ICT design.

Identify the uses of assistive technology.

Create accessible documents and multimedia.
Evaluate and repair websites for accessibility.
Identify components of ICT accessibility operations.

Title: ICT100X Information and Communication Technology (ICT) Accessibility MOOC
Link: https://www.edx.org/course/information-communication-technology-ict-ict100x



https://www.edx.org/course/information-communication-technology-ict-ict100x

AccessGA

I AMAC

ACCESSIBILITY

AccessGA represents a joint initiative of the Georgia
ADA Coordinator’s Office, AMAC, and GTA. The
objective is to support Georgia’s state agencies with
ICT accessibility, and promote equal and timely

access for employees and customers with a wide
range of disabilities.

1§ AccessGA

Georgia's Accessible ICT Initiative



AccessGA Offerings I\ AMAC
ACCESSIBILITY

Webinar Offerings

Technical Assistance and Hands-On Training

Monthly Newsletters

Up-to-Date Wiki of ICT Accessibility Resources and Information
Web Accessibility Audits

Procurement and VPATs

1§ AccessGA

Georgia's Accessible ICT Initiative



Contact Information

Tim Georges
Digital Media Specialist

y

AMAC

ACCESSIBILITY - Email: igeorgesﬁ@gatech.edu



mailto:jgeorges6@gatech.edu

What Have You Learned

AMAC

ACCESSIBILITY

Janet Sylvia, AMAC
Coordinator - Web Accessibility Group (WAG) for Higher Education



Around-the-Room I AMAC
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Name one accessibility requirement you can implement this week



Challenge I AMAC

ACCESSIBILITY

Be an Accessibility Champion
* Become the voice of accessibility on project teams, committees, etc.




How AMAC Can Help

AMAC

ACCESSIBILITY

Janet Sylvia, AMAC
Coordinator - Web Accessibility Group (WAG) for Higher Education



About WAG I AMAC

ACCESSIBILITY

WAG, an AMAC Initiative

* Bring together individuals seeking to comply with web accessibility laws, guidelines and best
practices in higher education (and beyond)

Benefits
* Listserv
* WAG Meetings
* Special Events
* Spotlight
* Website



Follow-up Webinar I AMAC

ACCESSIBILITY

Thursday December 9, 2017 from 9:00am — 10:00am

Follow-up Assistance
Q/A and Discussion
Login Link will be sent to today’s participants



Questions?, Part 4

AMAC

ACCESSIBILITY



Contact Information
Janet Sylvia, AMAC
WAG Coordinator

Questions or Join WAG Listserv

écbs/slﬁtg wag@amac.gatech.edu
Thanks for joining us today!



mailto:wag@amac.gatech.edu
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